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Application Notes for Configuring Windstream with Avaya 

IP Office (7.0.5) - Issue 1.0 
 

 

Abstract 
 

  

These Application Notes describe the procedures for configuring Session Initiation Protocol 

(SIP) Trunking between service provider Windstream and Avaya IP Office. 

 

Windstream SIP Trunking provides PSTN access via a SIP trunk between the enterprise and 

the Windstream network as an alternative to legacy analog or digital trunks. This approach 

generally results in lower cost for the enterprise. 

 

Windstream is a member of the Avaya DevConnect Service Provider program. Information in 

these Application Notes has been obtained through DevConnect compliance testing and 

additional technical discussions. Testing was conducted via the DevConnect Program at the 

Avaya Solution and Interoperability Test Lab. 
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1. Introduction 
  These Application Notes describe the procedures for configuring Session Initiation Protocol 

(SIP) Trunking between service provider Windstream and Avaya IP Office. 

 

Windstream SIP Trunking provides PSTN access via a SIP trunk between the enterprise and the 

Windstream network as an alternative to legacy analog or digital trunks. This approach generally 

results in lower cost for the enterprise. 

2. General Test Approach and Test Results  
The general test approach was to connect a simulated enterprise site to the Windstream SIP 

Trunk service via the public Internet and exercise the features and functionality listed in Section 

2.1.  The simulated enterprise site was comprised of Avaya IP Office and various Avaya 

endpoints. 

2.1. Interoperability Compliance Testing / Results 

A simulated enterprise site with Avaya IP Office was connected to Windstream SIP Trunking. 

To verify SIP trunking interoperability, the following features and functionality were exercised 

during the interoperability compliance test: 

 

 Response to SIP OPTIONS queries 

 Incoming PSTN calls to various Avaya phone types.  Phone types included H.323, SIP, 

digital, and analog telephones at the enterprise. All inbound PSTN calls were routed to 

the enterprise across the SIP trunk from the service provider. 

 Outgoing PSTN calls from various phone types.  Phone types included H.323, SIP, 

digital, and analog telephones at the enterprise.  All outbound PSTN calls were routed 

from the enterprise across the SIP trunk to the service provider. 

 Inbound and outbound PSTN calls to/from soft clients Avaya IP Office supports two soft 

clients: Avaya IP Office Phone Manager and Avaya IP Office Softphone.  Only Avaya IP 

Office Softphone was tested. 

 Various call types including: local, long distance, international, outbound toll-free and 

 Directory assistance 

 Codec G.711MU 

 Caller ID presentation and Caller ID restriction 

 Voicemail navigation for inbound and outbound calls 

 User features such as hold and resume, transfer, and conference 

 Off-net call forwarding and twinning 

 G.711 Faxing inbound and outbound 

 SIP REFER on transfer and forward 

 

Items not supported or not tested included the following: 

 Inbound toll-free and emergency calls (911) are supported but were not tested as part of 

the compliance test. 

 Operator services are supported but were not tested. 
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 Codec negotiation of multiple codecs between Windstream and Avaya was not tested 

since Windstream currently supports only one codec (G.711MU) for SIP Trunking. 

 

Interoperability testing of Windstream SIP Trunking was completed with successful results for 

all test cases with the exception of the observations/limitations described below. 

 

 SIP OPTIONS message response:  IP Office sends SIP OPTIONS messages to the 

Windstream SIP gateway and Windstream returns a 501 Not Implemented.  A 200 OK 

is the usual response but the IP Office only requires a response, not a specific message.  

However, Check OOS on the Line SIP Line must be unchecked for IP Office to 

consider the SIP Line in-service.  See Section 5.5 for more details. 

 Codec mismatch on Outbound calls: When incompatible codecs are configured, 

outbound calls succeed but caller gets dead air and then the call drops and phone displays 

“INCOMPATIBLE”. Inbound calls do not go through and caller hears an appropriate 

rejection message. 

 RFC2833 Not  Supported: Only Inband DTMF is supported. 

 T.38 FAX Not Supported: Only G.711 Fax is supported. 

 Outbound Call Number Restriction Not Supported: On Outbound calls from the 

Avaya IP Office when Called-ID is restricted, Windstream does not allow that call to go 

through.  Inbound calls with restricted caller-id complete and display “Anonymous / 

Private” 

 Off-net call forwarding:  When an inbound call is placed to a station with forwarding 

enabled and the forwarding number is an off-net PSTN number, RTP Keepalives on LAN 

2 must be enabled or the call will complete, but receive dead-air. LAN2 is the interface 

typically used to connect to the SIP Service Provider.Twinning:  RTP Keepalives on 

LAN2 must be enabled for proper functioning.  LAN2 is the interface typically used to 

connect to the SIP Service Provider. 

 Call display update: Call display was not properly updated on PSTN phone to reflect 

the true connected party on calls that are transferred to the PSTN from the enterprise.  

After the call transfer was completed, the PSTN phone showed the party that initiated the 

transfer instead of the actual connected party. 

 IP Softphone – must have Call Waiting On and Offhook Station checked on the User 

Telephony Call Settings page to allow for proper transfer and forwarding 

capabilities. 

 SIP REFER – Windstream does not support SIP REFER at this time, but will in a later 

release, it is therefore recommended that REFER not be enabled.  REFER is enabled by 

checking “REFER Support” under Line17 in the reference configuration. 

2.2. Support 

For technical support on the Avaya products described in these Application Notes visit 

http://support.avaya.com. 

 

For technical support on Windstream SIP Trunking, contact Windstream using the Customer 

Service links at www.windstream.com. 

http://support.avaya.com/
www.windstream.com
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3. Reference Configuration 
Figure 1 illustrates the test configuration. The test configuration shows an enterprise site 

connected to Windstream SIP Trunking. 

 

Located at the enterprise site is an Avaya IP Office 500 V2 with ATM Combination Card (6210) 

and Digital Station Base Card (TCM8). The LAN1 port of Avaya IP Office is connected to the 

enterprise LAN while LAN2, the WAN port, is connected to the public network. Endpoints 

include an Avaya 1140E Series (SIP firmware) registered to IP Office, Avaya 1600 Series IP 

Telephone (with H.323 firmware), an Avaya 1400 Series Digital Telephone, an Avaya T7100 

Digital Telephone (Legacy Nortel), an Avaya 6210 Analog Telephone, an Avaya IP Office 

Softphone, and Avaya IP Office Phone Manager with embedded voicemail. 

 
Figure 1: Avaya IP Telephony Network Connecting to Windstream SIP Trunking Service 
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For security purposes, any public IP addresses or PSTN routable phone numbers used in the 

compliance test are not shown in these Application Notes. Instead, public IP addresses have been 

replaced with private addresses and all phone numbers have been replaced with numbers that 

cannot be routed by the PSTN. 

 

For the purposes of the compliance test, users dialed a short code of 9 + N digits to send digits 

across the SIP trunk to Windstream. The short code of 9 is stripped off by Avaya IP Office but 

the remaining N digits were sent unaltered to Windstream. For calls within the North American 

Numbering Plan (NANP), the user dialed 11 (1 + 10) digits. Thus for these NANP calls, Avaya 

IP Office sent 11 digits in the Request URI and the To field of an outbound SIP INVITE 

message. It was configured to send 10 digits in the From field. For inbound calls, Windstream 

SIP Trunking sent 10 digits in the Request URI and the To field of inbound SIP INVITE 

messages. 

 

Windstream uses the phone number in the From header of a SIP INVITE message to authenticate 

the calling party. Thus, a call will be rejected by the network unless the From header contains a 

number known to Windstream. This is especially important for calls inbound from the PSTN 

which are redirected back to the PSTN by call forwarding or twinning. For call forwarding, 

Avaya IP Office always sends the number of the forwarding phone in the From header. This is a 

number known to Windstream. As a result, the call display on the destination phone shows the 

forwarding party not the original caller. For twinning, this behavior can be slightly altered 

through configuration. See Section 5.4 and 5.5.3 for details. 

 

In an actual customer configuration, the enterprise site may also include additional network 

components between the service provider and the Avaya IP Office such as a session border 

controller or data firewall. A complete discussion of the configuration of these devices is beyond 

the scope of these Application Notes. However, it should be noted that SIP and RTP traffic 

between the service provider and the Avaya IP Office must be allowed to pass through these 

devices. 
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4.  Equipment and Software Validated 
The following equipment and software were used for the sample configuration provided: 

Avaya IP Telephony Solution Components 

Component Release 

Avaya IP Office 500 v2 

ATM Combination Card (6210) 

Digital Station Base Card (TCM8) 

7.0.5 

Avaya 1140E Series IP Telephone (SIP) 04.01.13.00 

Avaya 1616L Series IP Telephone (H323) 1.3000 

Avaya 1408 Digital Telephone n/a 

Avaya T7100 Digital Telephone n/a 

Avaya 6210 Analog Telephone n/a 

Avaya IP Office Softphone (SIP) 3.1.2.17 (59616) 

Windstream Voice and Data Bundle – SIP Components 

Component Release 

Metaswitch - CFS 7.1.01-B48 P90.41 

Metaswitch - UMG 7.1.01-SU64 P86.00 

Metaswitch - EMS 7.3.00-SU16 P86.00 

Adtran – TA908E A02.06 

 

Table 1: Equipment and Software Tested 

5. Configure Avaya IP Office 
This section describes the Avaya IP Office configuration to support connectivity to Windstream 

SIP Trunking. Avaya IP Office is configured through the Avaya IP Office Manager PC 

application. From a PC running the Avaya IP Office Manager application, select Start  
Programs IP Office  Manager to launch the application. Navigate to File Open 

Configuration, select the proper Avaya IP Office system from the pop-up window, and log in 

with the appropriate credentials.  A management window will appear similar to the one in the 

next section. All the Avaya IP Office configurable components are shown in the left pane known 

as the Navigation Pane. The pane on the right is the Details Pane. These panes will be referenced 

throughout the Avaya IP Office configuration. All licensing and feature configuration that is not 

directly related to the interface with the service provider (such as twinning and IP Office 

Softphone support) is assumed to already be in place. A screen that includes the following in the 

center may be displayed: 
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Open the IP Office configuration, either by reading the configuration from the IP Office server, or 

from file. The appearance of the IP Office Manager can be customized using the View menu. In the 

screens presented in this section, the View menu was configured to show the Navigation pane on the 

left side, the Group pane in the center, and the Details pane on the right side. 

5.1. Licensing and Physical Hardware 

The configuration and features described in these Application Notes require the IP Office system 

to be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity, 

contact an authorized Avaya sales representative.  
 

To verify that there is a SIP Trunk Channels License with sufficient capacity; click License in 

the Navigation pane and SIP Trunk Channels in the Group pane. Confirm a valid license with 

sufficient “Instances” (trunk channels) in the Details pane. 

 
 

If Avaya IP Telephones will be used as is the case in these Application Notes, verify the Avaya 

IP endpoints license. Click License in the Navigation pane and Avaya IP endpoints in the 

Group pane. Confirm a valid license with sufficient “Instances” in the Details pane. 
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5.2. Physical, System and Network Settings 

This section describes attributes of the sample configuration, but is not meant to be prescriptive. 

Consult reference [IPO-INSTALL] for more information on the topics in this section.  

5.2.1. Physical Configuration and Settings 

In the sample configuration, looking at the IP Office 500 v2 from left to right, the first module is the 

TCM8 card, a digital station module, the next slot from left to right contains the COMBO 6210/ 

ATM4 card, an analog and digital combo card, and the last slot was blank (i.e., no module is 

physically inserted). The TCM8 module allows connection of legacy Nortel digital stations, a T7100 

was used in this configuration. The COMBO6210/ATM module allows connection of analog and 

Avaya digital endpoints. In the testing of the sample configuration, an analog telephone or a fax 

machine is connected to port 8 of the module and an Avaya 1408 digital station is connected to port 

1. 

 

The following screen shows the modules in the IP Office used in the sample configuration. To access 

such a screen, select Control Unit in the Navigation pane. The modules appear in the Group pane. In 

the screen below, IP 500 V2 is selected in the Group pane, revealing additional information about the 

IP 500 in the Details pane. 
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5.2.2. System Settings 

Select System from the Navigation pane to access the main system menu.  The Name field can be 

used for a descriptive name of the system, Windstream1 is used here. The TFTP and HTTP server 

fields indicate the Avaya IP Office LAN1 IP Address for endpoints to discover.  The Avaya HTTP 

Clients Only and Enable SoftPhone HTTP Provisioning boxes are checked to facilitate Avaya IP 

Office Softphone usage. 

 

5.2.3. LAN1 Settings 

Under SystemLAN1LAN Settings, the IP Address of the LAN Interface is set, along with 

the IP Mask of the subnet and the DHCP Mode.  Here the LAN1 IP Address is 10.80.140.35 

with a mask of 255.255.255.0 and the DHCP Mode is set to Server.  The indicates that 

Advanced DHCP settings are being used and by rolling the mouse over the  button you can 

see the notice.  The DHCP Pools tab will display the DHCP config (not shown). 
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In the sample configuration, the IP Office LAN1 port is physically connected to the local area 

network switch at the IP Office customer site. The default gateway for this network is 10.80.140.1. 

To add an IP Route in IP Office, right-click IP Route from the Navigation pane, and select New. To 

view or edit an existing route, select IP Route from the Navigation pane, and select the appropriate 

route from the Group pane. The following screen shows the Details pane with the relevant default 

route using Destination LAN1. 

 

5.2.4. LAN2 Settings 

In the sample configuration, the WAN port was used to connect the Avaya IP Office to the 

public network. The LAN2 settings correspond to the WAN port on the Avaya IP Office. To 

access the LAN2 settings, first navigate to System Windstream1 in the Navigation Pane and 

then navigate to the LAN2LAN Settings tab in the Details Pane. Set the IP Address field to 

the IP address assigned to the Avaya IP Office WAN port. Set the IP Mask field to the mask 

used on the public network. All other parameters should be set according to customer 

requirements. 
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On the VoIP tab in the Details Pane, check the SIP Trunks Enable box to enable the 

configuration of SIP trunks. The RTP Port Number Range can be customized to a specific 

range of receive ports for the RTP media. Based on this setting, Avaya IP Office would request 

RTP media be sent to a UDP port in the configurable range for calls using LAN2. Avaya IP 

Office can also be configured to mark the Differentiated Services Code Point (DSCP) in the IP 

Header with specific values to support Quality of Services policies for both signaling and media. 

The DSCP field is the value used for media and the SIG DSCP is the value used for signaling. 

RTP Keepalives must be enabled or Forwarding Off-net and Twinning does not function 

properly. The specific values used for the compliance test are shown in the example below. All 

other parameters should be set according to customer requirements. 
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On the Network Topology tab in the Details Pane, configure the following parameters: 

 

 Select the Firewall/NAT Type from the pull-down menu that matches the 

network configuration. No firewall or network address translation (NAT) device 

was used in the compliance test as shown in Figure 1, so the parameter was set to 

Open Internet. 

 Set Binding Refresh Time (seconds) to 0. This value is used as one input to 

determine the frequency at which Avaya IP Office will send SIP OPTIONS 
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messages to the service provider. Windstream  responds to OPTIONS messages 

with a 501 Not Implemented, so this was set to 0, which means that OPTIONS 

messages are sent only every 5 minutes. 

 Set Public IP Address to the IP address of the Avaya IP Office WAN port. 

 All other parameters should be set according to customer requirements. 

 

 

5.3. Voicemail 

In the sample configuration, Embedded Voicemail was used.  To change voicemail settings, 

navigate to System Voicemail as shown below. 
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5.4. System Telephony Settings 

Navigate to the Telephony Telephony Tab on the Details Pane. Set the Automatic Codec 

Preference for the default codec to be used for intra-enterprise traffic. Choose the Companding 

Law typical for the enterprise location. For North America, ULAW is used. Uncheck the Inhibit 

Off-Switch Forward/Transfer box to allow call forwarding and call transfer to the PSTN via 

the service provider across the SIP trunk. 

 

5.5. Twinning Calling Party Settings 

When using twinning, the calling party number displayed on the twinned phone is controlled by 

two parameters. These parameters only affect twinning and do not impact the messaging or 

operation of other redirected calls such as forwarded calls. The first parameter is the Send 

original calling party information for Mobile Twinning box on the SystemTwinning tab. 

The second parameter is the Send Caller ID parameter on the SIP Line form (shown in Section 

5.6). If this box (representing the first parameter) is checked, the setting of the second parameter 

is ignored and Avaya IP Office will send the following in the SIP From Header: 

 

 On calls from an internal extension to a twinned phone, Avaya IP Office will send 

the calling party number of the originating extension. 

 On calls from the PSTN to a twinned phone, Avaya IP Office will send the calling 

party number of the host phone associated with the twinned destination (instead of 

the number of the originating caller). 

 

If this box is unchecked, the value sent in the SIP From header is determined by the setting of the 

second parameter. For the compliance test, the Send original calling party information for 

Mobile Twinning box on the SystemTwinning tab was checked which overrides any setting 
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of the Send Caller ID parameter on the SIP Line form.  Click the OK Button at the bottom of 

the page (not shown). 

 
 

To have the caller-id displayed on the twinned phone be the originating caller instead of the host 

phone associated with the twinned destination on a PSTN call, the Send original calling party 

information for Mobile Twinning box on the SystemTwinning tab must be unchecked and 

the Send Caller ID parameter on the SIP Line form must be set to Diversion Header.  

 

5.6. Administer SIP Line 

This section shows the configuration screens for the SIP Line in IP Office Release 7. Since IP Office 

Release 7 introduced new SIP Line parameters and re-oriented existing parameters, this section has 

the most substantive changes in these Application Notes. 

5.6.1. SIP Line - SIP Line Tab 

A SIP line is needed to establish the SIP connection between Avaya IP Office and Windstream 

SIP Trunking. To create a SIP line, begin by navigating to Line in the Navigation Pane. Right-

click and select New SIP Line. On the SIP Line tab in the Details Pane, configure the 

parameters as shown below. 
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 Set ITSP IP Address to the IP address of the Windstream SIP proxy. 

 Set Send Caller ID to None. For the compliance test, this parameter was ignored 

since the Send original calling party information for Mobile Twinning box is 

checked in Section 5.5 

 Check the In Service box. 

 Uncheck the Check OOS box since OPTIONS messages are not supported.  This 

MUST be unchecked or IP Office will never consider the trunk in service since 

the OPTIONS messages are not being responded to properly. 

 UnCheck REFER Support since Windstream does not support REFER at this 

time. 

 Default values may be used for all other parameters. 

 

5.6.2. SIP Line - Transport Tab 

Select the Transport tab. This tab was introduced in Release 6.1. Some information configured in 

this tab had been under the SIP Line tab in Release 6.0.  

 

The ITSP Proxy Address is set to the IP Address provided by Windstream. As shown in Figure 1, 

this IP Address is 10.2.2.2. In the Network Configuration area, UDP is selected as the Layer 4 

Protocol, and the Send Port is set to the port number provided by Windstream.  The Use Network 

Topology Info parameter is set to “LAN 2”. This associates the SIP Line with the parameters in the 

System LAN2 Network Topology tab. 
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5.6.3. SIP Line - SIP URI Tab 

A SIP URI entry must be created to match each incoming number that Avaya IP Office will 

accept on this line. To create a SIP URI entry, first select the SIP URI tab. Click the Add button 

and the New Channel area will appear at the bottom of the pane. For the compliance test, a 

single SIP URI entry was created that matched any number assigned to an Avaya IP Office user. 

The entry was created with the parameters shown below. 

 Set Local URI, Contact, Display Name, and PAI to Internal Data. This setting 

allows calls on this line whose SIP URI matches the number set in the SIP tab of 

any User as shown in Section 5.8.1. 

 Associate this line with an incoming line group by entering a line group number 

in the Incoming Group field. This line group number will be used in defining 

incoming call routes for this line. Similarly, associate the line to an outgoing line 

group using the Outgoing Group field. The outgoing line group number is used 

in defining short codes for routing outbound traffic to this line. For the 

compliance test, a new incoming and outgoing group 17 was defined that only 

contains this line (line 17). 

 Set Max Calls per Channel to the number of simultaneous SIP calls that are 

allowed using this SIP URI pattern. 
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Select the VoIP tab, to set the Voice over Internet Protocol parameters of the SIP line. Set the 

parameters as shown below. 

 Set the Compression Mode to G.711 ULAW 64K. Windstream only supports 

G.711ULAW at this time. 

 Set Fax Transport Support box to G.711. T. 38 is not supported at this time. 

 Set the DTMF Support field to Inband. This is the only option Windstream 

supports. 

 Check the Re-invite Supported box. 

 Check the Use Offerer’s Preferred Codec.  Normally for SIP calls, the initiator 

of the calls sends a SIP offer which includes the codecs that they support in order 

of preference. The SIP response includes the codec they want to use for the call. 

This option can be used to override that behaviour and use the codec preference 

offered by the caller. 

 Default values may be used for all other parameters. 

 

Click the OK button at the bottom of the page (not shown). 
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5.7. Short Code 

Define a short code to route outbound traffic to the SIP line. To create a short code, right-click 

on Short Code in the Navigation Pane and select New. On the Short Code tab in the Details 

Pane, configure the parameters as shown below. 

 In the Code field, enter the dial string which will trigger this short code, followed 

by a semicolon. In this case, 9N;. This short code will be invoked when the user 

dials 9 followed by any number. 

 Set Feature to Dial. This is the action that the short code will perform. 

 Set Telephone Number to N”@10.2.2.2”. This field is used to construct the 

Request URI and To headers in the outgoing SIP INVITE message. The value N 

represents the number dialed by the user. The IP address 10.2.2.2 is the IP address 

of the Windstream SIP proxy. 

 Set the Line Group Id to the outgoing line group number defined on the SIP 

URI tab on the SIP Line in Section 5.6.1. This short code will use this line group 

when placing the outbound call. 

Click the OK button (not shown). 

 

 

5.8. User 

In this section, examples of IP Office Users and Extensions will be illustrated. In the interests of 

brevity, not all users and extensions shown in Figure 1 will be presented, since the configuration can 
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be easily extrapolated to other users. To add a User, right click on User in the Navigation pane, and 

select New. To edit an existing User, select User in the Navigation pane, and select the appropriate 

user to be configured in the Group pane. 

5.8.1. User 1143 

The following screen shows the User tab for User 1143. This user corresponds to the  H.323 

telephone 1616L. 

 
 
The following screen shows the SIP tab for User 1143. The SIP Name and Contact parameters are 

configured with a Windstream SIP Trunk DID number for the user, 5015551143.  These parameters 

configure the user part of the SIP URI in the From header for outgoing SIP trunk calls, and allow 

matching of the SIP URI for incoming calls from Windstream SIP Trunk Service, without having to 

enter this number as an explicit SIP URI for the SIP Line. The SIP Display Name (Alias) parameter 

can optionally be configured with a descriptive name. Anonymous cannot be checked to withhold 

user information as Windstream does not allow call-id restrictions on outgoing calls. 
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User 1143 will use the Mobile Twinning feature. The following screen shows the Mobility tab for 

User 1143. The Mobility Features and Mobile Twinning boxes are checked. The Twinned Mobile 

Number field is configured with the number to dial to reach the twinned mobile telephone, in this 

case 913035551856, with 9 being a short code, see Section 5.7. Other options can be set according to 

customer requirements. 

 

5.9. Incoming Call Route 

An incoming call route maps an inbound DID number on a specific line to an internal extension. 
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This procedure should be repeated for each DID number provided by the service provider. To 

create an incoming call route, right-click Incoming Call Routes in the Navigation Pane and 

select New.  On the Standard tab of the Details Pane, enter the parameters as shown below. 

• Set the Bearer Capacity to Any Voice. 

• Set the Line Group Id to the incoming line group of the SIP line defined in 

Section 5.6.1 

• Set the Incoming Number to the incoming number on which this route should 

match. Matching is right to left. 

• Default values can be used for all other fields. 

 
 

On the Destinations tab, select the destination extension from the pull-down menu of the 

Destination field. Click the OK button (not shown). In this example, incoming calls to 

5015551143 on line 17 are routed to extension 1143. 

 

5.10. Save Configuration 

When desired, send the configuration changes made in IP Office Manager to the IP Office server, to 

cause the changes to take effect. Click the “disk” icon that is the third icon from the left (i.e., 

common “save” icon with mouse-over help “Save Configuration File”). Click Yes to validate the 

configuration, if prompted. 
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Once the configuration is validated, a screen similar to the following will appear, with either 

“Merge” or “Immediate” selected, based on the nature of the configuration changes made since the 

last save. Note that clicking OK may cause a service disruption. Click OK if desired. 

 

 

6. Windstream SIP Trunking Configuration 
Windstream is responsible for the configuration of Windstream SIP Trunking. The customer will 

need to provide the IP address used to reach the Avaya IP Office at the enterprise.  This is the 

LAN2 address configured in Section 5.2.4.  Windstream will provide the customer the necessary 

information to configure the Avaya IP Office SIP connection to Windstream including: 

• IP address of the Windstream SIP proxy 
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• Supported codecs 

• DID numbers 

• All IP addresses and port numbers used for signaling or media that will need 

access to the enterprise network through any security devices. 

7. Verification Steps 
This section provides verification steps that may be performed in the field to verify that the 

solution is configured properly. 

7.1. System Status 

The System Status application is used to monitor and troubleshoot IP Office.  Use the System 

Status application to verify the state of the SIP trunk.  System Status can be accessed from Start 

→Programs →IP Office →System Status.  Or by opening an Internet browser and type the 

URL: http://ipaddress where ipaddress is the IP address of the Avaya IP Office LAN1 interface.  

Click on System Status to launch the application. 

 

 
 

The following screen shows an example Logon screen. Enter the IP Office IP address in the 

Control Unit IP Address field, and enter an appropriate User Name and Password. Click 

Logon. 
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Select the SIP line under Trunks from the left pane.  On the Status tab in the right pane, verify 

the Current State is Idle for each channel. 

 
 

Select the Alarms tab and verify that no alarms are active on the SIP line. 
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7.2. Monitor 

The Monitor application can also be used to monitor and troubleshoot IP Office.  Monitor can be 

accessed from Start →Programs →IP Office →Monitor.  The application allows the 

monitored information to be customized. To customize, select the button that is third from the 

right in the screen below, or select Filters →Trace Options.  
 

The following screen shows the SIP tab, allowing configuration of SIP monitoring. In this 

example, the SIP Rx and SIP Tx boxes are checked. All SIP messages will appear in the trace 

with the color blue. To customize the color, right-click on SIP Rx or SIP Tx and select the 

desired color. 

 
 

As an example, the following shows a portion of the monitoring window for an outbound call 

from extension 1145, whose DID is 501-555-1145, calling out to the PSTN via the Windstream 

IP Trunking Service. The telephone user dialed 9-1-303-555-1212. 

 



 
MEO; Reviewed: 

SPOC 10/21/2011 

Solution & Interoperability Test Lab Application Notes 

©2011 Avaya Inc. All Rights Reserved. 

27 of 29 

Windstream_Ipo7 

 

 
 

 Verify that a phone connected to Avaya IP Office can successfully place a call to the 

PSTN with two-way audio. 

 Verify that a phone connected to PSTN can successfully place a call to the Avaya IP 

Office with two-way audio. 

8. Conclusion 
The Windstream SIP Trunking passed compliance testing. These Application Notes describe the 

procedures required to configure the connectivity between Avaya IP Office and the Windstream 

SIPTrunking as shown in Figure 1. 

9. References 
This section references the documentation relevant to these Application Notes. Additional 

Avaya product documentation is available at http://support.avaya.com. 
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Product documentation for Avaya products may be found at http://support.avaya.com. 

Product documentation for Windstream SIP Trunking is available from Windstream.  

http://www.ietf.org/
http://www.ietf.org/
http://www.ietf.org/
http://support.avaya.com/
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